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Ordering TargetSeq™ Custom Enrichment Kits

TargetSeq™ Custom Enrichment Kits provide a convenient method to
enrich for targeted genomic regions. This guide helps you generate the
data required to place your order and review the resulting design
provided by Life Technologies.

About the ordering process

TargetSeq™ Custom Enrichment Kit ordering and production is a multi-
phase process. The workflow (see right) describes the entire process

from beginning to end. The design and approval phases are performed
via email, and they require customer participation.

Note: After a panel design is approved, production begins and the
order is irrevocable.

About the order and design files
You will exchange design files with Life Technologies at least twice:
e First, when submitting your coordinates file, and

e Again, when Life Technologies submits the panel design for your
approval.

The following table describes the files that you will send to and receive
from Life Technologies during the design phase.

File Description

Coordinates file A customer-created, tab-delimited text file
(.txt) that contains the design specifications for a
custom design order.

Browser Extensible
Data file (.bed)

Design files created by Life Technologies
that can be read using the UCSC Genome
Browser.

[] - Customer action
Start [[] - Life Technologies action

Download the TargetSeq™ Custom
Enrichment Kit Design Request Form

-

Generate a list of genomic coordinates
for your TargetSaq ™ Kit order

.

Email the completed order form, purchase order,
and coordinates file to Life Technologies

-

Life Technologies emails you to confirm receipt
of your order, then reviews the arder files

Order form

Life Technalogies
emails you for
corections or

clarification

T

approved?

Life Technologies emails the design 1o you
for appraval

!

Review and approve the design

Design
approved? Na

Yes

Email questions
andior changes o
Lifie Technologies

Summary Design
file (.txt)

A text file that describes the properties of
your TargetSeq™ Custom Design.

Life Technolegies emalls corfirmation of ardar
including approximate delivery date

!

Life Technologies ships the order to you

s

T

technologies”
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Submitting custom designs to Life Technologies

This section describes how to use the UCSC Genome Browser to generate a list of genome coordinates for use in specifying your capture
or tiling regions. You will email the resulting coordinates file along with your purchase order and the completed TargetSeq™ Custom
Enrichment Kit Library Design Request Form to Life Technologies to begin the design phase.

Note: This section uses HG18 as an example genome. Different builds available in the tool may produce slight differences in output.

About the UCSC Genome Browser

You will use the following features of the UCSC Genome Browser website in this procedure.

Feature Description

Table Browser | Used to generate a .bed file of chromosome locations and exon start and stop coordinates, which are the elements
needed by the array design team to create a custom design. The feature can also display a page of these coordinates,
which can be copied and pasted into other applications.

Gene Sorter Used to search for a gene name or for genes that have similarities to a search term and can be used to generate a
gene list with one gene per line.

Step 1: Generate a Gene List

In this procedure you will use the UCSC Genome Browser to generate a gene list. The gene list
(see right] is a tab-delimited, text file that contains a list of accession (NM) numbers and gene
names (optional] for your regions of interest. Each line of the file lists an accession number and
an optional gene name for a single gene of interest, separated by a tab character.

I scnBa_genelist. txt - Notepad
File Edit Format View Help

Note: If necessary, you can create the gene list file manually.

MM_000215

1 Open the UCSC Genome  Open the UCSC Genome Browser website (http://genome.ucsc.edu).

Browser If you already created a gene list, go to “Step 2: Convert Gene List to Chromosomal Coordinates” on

page 6.

{= UCSC Genome Browser Home - Windows Internet Explorer,
@ L A |§ http: f{genome, ucsc.eduf Q) v| hed| B I:

File Edit V¥iew Favorites Tools Help @Snagit E =)

i’:? ﬁ'ﬁ [.UCSC Genome Browser Home l_l @ ke E

LUCSC Genome Bioinformatics

2 Open the Gene Sorter In the UCSC Genome Browser home page, click Gene Sorter.

UCSC Genome Bioinformatics

Genomes - Blat - Tables - Gene Sorter < e - VisiGene - Proteome

i About the UCSC Genome Bioinformatics Site

Elpem Welcome to the UCSC Genome Browser website. This site contains the reference sequence and working ¢
ENCODE collection of genomes. It also provides portals to the ENCODE and Neandertal projects.

Meandertal We encourage you to explore these sequences with our tools. The Genome Browser zooms and scrolls ov
— the work of annotators worldwide. The Gene Sorter shows expression, homology and other information o
Blat be related in many ways. Blat quickly maps your sequence to the genome. The Table Browser provides

underlying database. VisiGene lets you browse through a large collection of in situ mouse and frog imag
patterns. Genome Graphs allows you to upload and display genome-wide data sets.

Table
Browser

¥ UCSC Genome Browser is developed and maintained by the Genome Bioinformatics Group, a cross
—_— we Center for Biomolecular Science and Engineering (CBSE) at the University of California Santa Cr
In Silico PCR feedback or questions concerning the tools or data on this website, feel free to contact us on our public maili
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Open the Gene Sorter Initially the “About the Gene Sorter” page appears; this page displays the Gene Sorter tool at the top

[continued) of the page and the instructions at the bottom. Use the Gene Sorter tool to search for similar genes
from the curated UCSC database by entering any kind of gene name, accession number, or other term
in the search field. The Gene Sorter page displays search results in a table with a set of columns that
can be customized by clicking configure.

UCSC Human Gene Sorter

cenom [Fuman ) assembiy [ Wor 2005 NCBI06gT0) 9] search =

sort by | Protein Homology - BLASTP v| [_configure | [ filter (now off) | gisplay [25 | output

About the Gene Sorter

This program displays a sorted table of genes that are related to one another. The relationship can be one of several types,
including protein-level homology, similarity of gene expression profiles, or genomic proximity.

To display a gene and its relatives:

1. Select a genome and assembly from the corresponding pull-down menus.

2. Type a word or phrase into the search text box to specify which gene should be displayed in the Gene Sorter.
Examples of search terms include FOXA2, HOXA9, and MAP linase.

3. Choose the gene relationshin with which vou would like to sort the list bv selecting an option from the sort by pull-

Configure the search a. In the UCSC Human Gene Sorter page, click configure.
options In the Configure Gene Sorter page, select the check box in the On column for the RefSeq row.

Note: In the example below, selected tracks include #, Name, RefSeq, and Description (not
shown).

c. Click submit to return to the main UCSC Human Gene Sorter page.

Configure Gene Sorter

@ Cohm:ms:[ hide all ” show all H default ]Scttings:[save]

Expression ratio colors: | red high/greenlow % | Show all splicing variants: []

Name on Description Configuration
" P~ Item Number in Displayed List/Select w/a

Gene
Name Gene Name/Select Gene n'a
UniProtKB | [] |4 UniProtKB Protein Display ID n'a
};r;fmﬂ(B [ A UniProtKDB Protein Accession n'a
RefSeq @ INCBI RefSeq Gene Accession n'a
Entrez Gene |[] .4 % NCBI Entrez Gene/LocusLink ID n'a
UCSC ID ]| A [UCSC Transcript ID n'a
4 Perform the search a. Enter one or more keywords in the search field, then configure the search parameters
appropriately.

For example, enter “BDNF” in the search field, then select “Protein Homology - BLASTP” in the
sort by field to set up a search by protein sequence homology.

UCSC Human Gene Sorter

genome | Human | assembly [ Mar. 2006 (NCBI36/hg18) | scarch [EDNF @—[ (Go]] ‘

soﬁb}r|Protein Homology - BLASTP VH configure ” filter (now off) ]d15p1a§,|59 "‘output

b. Click Go to run the search.

The tool returns the search results in a tabular list that includes columns for each of the selected
configuration parameters.
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Perform the search
(continued)

c. Click text to view the search results in a tab-delimited text format.

UCSC Human Gene Sorter

genome | Human +| assembly | Mar. 2006 (NCBI36/hg18) +| search [uc001mt1 | (Go}]
sgrtby|ProteinHomOIogy-BLASTP v“ configure ][ filter (now off) ]displa}'|59 "‘out‘putl sequence ]

#Hame RefSeq Description

1/ BDNF|NM_170734 brain-derived neurotrophic factor isoform ¢
2|NTF3 [NM_001102654 neurotrophin 3 isoform 1 preproprotein
3NTF4 [NM_006179 neurotrophin 5 preproprotein

The gene list is now in a format that you can copy and paste into other applications.

#num nate refleq description

1 EDNF HM 170734 brain-derived neurotrophic factor isoform c

2 NTF3 NM 001102654 neurotrophin 3 isoform 1 preproprotein

3 NTF4 NM 00e179 neurotrophin 5 preproprotein

4 NGF NM 00z50& nerve growth factor, kbeta polypeptide precursor

Copy and paste the
search results into
Microsoft Excel

a. Select and copy all of the text shown on the screen.
b. In Microsoft Excel, select Edit » Paste Special to paste the output into a blank worksheet.

c. Inthe Paste Special dialog, select Text in the Paste As field, then click OK to paste the data into
the worksheet in a one-value-per-cell format.

A

Paste Spe

a

(%) paste: HTML |

Uricode Text C

Result

Inserts the contents of the Clipboard as text
.‘él without any Formatting.,

Y Y

—
oo

Edit and save the data

Edit data as needed using Excel, then save the file (select File » Save).

Remove all but the
refSeq column

a. Remove all columns, except for refSeq, from the spreadsheet.
For example, remove columns A, B, and D so that only the refSeq column remains.

b. Remove the heading row (row 1) from the spreadsheet.

vy Y

| o [ E | F [ & | H | L

©,

(o)

- #num name refSeq description
1 BEDMNF Mi_17073 brain-derived neurotrophic factor isoform ¢
2 MTF3 Mh_00110 neurotrophin 3 isoform 1 preproprotein

)
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8

Save the gene list file

a. Select File » Save As to save the list of accession numbers in a tab-delimited text format (*.txt).

b. In the Save As dialog box, enter a name for the file, select Text (Tab-delimited)(*.txt) from the
Save as type drop-down list, then click Save.

A B | ¢ [ o | E [ F | & [ H [ 1 [ g |
1 Mra 17073
LT Save As
3 |NM_006173 Save in: @ - 3 [ e - -
TN D02508 i |@ Desktop v @-|Q@ X i B - Toos
? - A @ scnda_genelist, bxt |5 slides For Dan B
5| 4 [Z] cacnb4_like bxt 315047
7 | Iy Recent [Z] M5 2 4 Macos e4bit Launcher Seript_ReadMe.bxt 0315271
3 Documents 1) o darr bt 8163
T = @ Roche MimbleGen Software License, bxt ) UninstallerData
W [ @ Samplekey . bxt Chire
T Deskkop @ hgl&_promoter_probes,txt ) signalMap_v1.9
W @ arab_set.bxt () Minning
W & @ 4Plex_Seq {4).bxt [C5) Test MimbleScan 2.5
W _J @ 8785, singletons, 20479, bxt [C)PlugIns
? My Documents @ Designiotes. bxk @bin
B () Mew Folder (3) C)e4z1
17 | [ C)0ID11465 |C5)Weihong September 2008
W [ 11595 () Rensick_Cargil_IMages
EEl My Computer | =) gay [C5iMew Falder (21 @
20 e >
21 g File name: v | [ Sa've ]
22 Iy Metwork =
23 | Places Save as bype: |Text (Tab delimited) (*,kxk) v | Cancel
24 @

c. If Microsoft Excel displays the following warning, click OK.

Microsoft Excel

The selected file type does not support workbooks that contain multiple sheets,

17

« To save only the active sheet, dick OK.
« To save all sheets, save them individually using & different file name for each, or choose a file type that supports multiple sheets.

d. If Microsoft Excel displays the following warning, click Yes.

Microsoft Excel

Book2.txt may contain features that are not compatible with Text (Tab delimited). Do you want to keep the workbook in this format?

\:!_‘) « To keep this format, which leaves out any incompatible features, click Yes.
« To preserve the features, click No. Then save a copy in the latest Excel format.
 To see what might be lost, dick Help.

[ ‘fes ] [ Mo ] [ Help ]

You now have a tab-delimited gene list file that contains accession numbers that you can use to
generate exon coordinates for your order.

When viewed in Microsoft Notepad, the file appears as shown below.

I Untitled - Notepad
File Edit Format View Help

HM_170734
NM_001102654
MM_006179
MM_002506
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Step 2: Convert Gene List to Chromosomal Coordinates

In this procedure, you will use the accession numbers in the Gene List that you created in the previous section to generate a list of

chromosomal coordinates for the listed genes. The resulting file, which you will submit with your order, will contain the accession number,
chromosome number, and exon start and stop locations for your order.

1 Open the Table Browser
tool

In the UCSC Genome Browser, select Tables from the main menu bar (or Table Browser from the
list menu on the home page).

UCSC Genome Bioinformatics

Genomes - Blat - Tables - Gene Sorter - - VisiGene - Proteome

About the C Genome Bioinformatics Site

Welcome to the UCSC Genome Browser website. This site contains the reference sequence and working ¢
collection of genomes. It also provides portals to the ENCODE and Neandertal projects.

The Table Browser page appears as shown below with a description of the tool at the top of the page,
the Table Browser tool in the middle, and guidelines for use at the bottom.

Home Genomes Genome Browser Blat Tables Gene Sorter PCR Session FAQ Help

Table Browser

Use this program to retrieve the data associated with a track in text format, to calculate intersections between tracks, and to
retrieve DINA sequence covered by a track. For help in using this application see Using the Table Browser for a description
of the controls in this form, the User's Guide for general information and sample queries, and the OpenHelix Table Browser
tutorial for a narrated presentation of the software features and usage. For more complex queries, you may want to use
Galaxy or our public MySQL server. To examine the biological function of your set through annotation enrichments, send
the data to GREAT. Refer to the Credits page for the list of contributors and usage restrictions associated with these data.

clade: | Mammal v & :[Human | assembly:|Mar. 2006 (NCBI36/hg18) ~|

group: | Genes and Gene Prediction Tracks v| track: |UCSC Genes v
[ add custom tracks ] [ track hubs ]
table: | knownGene v| [ describe table schema ]

region: @ genome O ENCODE Pilot regions O position |chiX:151073054-151383976 |
[ lookup ” define regions ]

identifiers ( Tt }:[ pastelist | [ upload ist |

filter:
intersection:
correlation:
tput format: | BED - browser extensible data v| Send outputto [] Galaxy [] GREAT

t file: | | (leave blank to keep output in browser)
file type returned: & plaintext O gzip compressed

g

2 (Recommended) Reset
the user cart settings

(Recommended) In the Table Browser page, scroll to the bottom of the page, then click the click here

link in the line of text at the bottom of the window (below the “get output” button) to reset all user
cart settings.

file type returned: & plaintext O gzip compressed

[ get output ” summary/statistics ]

To reset all user cart settings (including custom tracks), click here@

Note: The UCSC browser remembers user settings. Clicking the “click here” link ensures that you
are using the correct settings rather than settings that might have been retained from a previous
browsing session. For example, clicking the link also automatically resets the genome as “Human”
and the assembly as “Feb. 2009". Note that the example still follows hg18 (Feb. 2006).
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Configure the Table a. In the Table Browser page, specify the settings as desired.

Browser settings For example, to use the March 2006 build of the human genome you would specify:
e genome - Human
e assembly - Mar. 2006

Table Browser

Use this program to retrieve the data associated with a track in text format, to calculate intersections between tracks, and to
retrieve DNA sequence covered by a track. For help in using this application see Using the Table Browser for a description
of the controls in this form, the User's Guide for general information and sample queries, and the OpenHelix Table Browser
tutorial for a narrated presentation of the software features and usage. For more complex queries, you may want to use
Galaxv or our public MvSQL server. To examine the biological function of your set through annotation enrichments, send
the data to GREAT. Refer to the Credits page for the ]i_onmbutors and usage restrictions a:.so with these data.

clade:  Mammal ¥| genome: Human ¥| assembly: Mar. 2006 (NCBI36/hg18) +

group: Genes and Gene Prediction Tracks ¥ | track: | UCSC Genes v
r o . . 1. D 1

b. From the output format drop-down list, select BED - browser extensible data.

intersection:
correlation:

output format: | BED - browser extensible data ¥ | Send output to [ Galaxy [ GREAT

output file: (leave blank to keep output in browser)

4 Upload the gene list file a. In the Table Browser page, click upload list beside the identifiers (names/accessions] field.

region: & genome O ENCODE Pilot regions O position |chrX:151073054-151383976
[ lookup ][ define regions ]

identifiers () lacc g ): [ paste list ] [ upload list

filter: @
intersection:

b. In the Upload Identifiers for UCSC Genes page, click Browse, then select the tab-delimited text
file containing your gene list that you created in step 2.

c. Click submit.

Upload Identifiers for UCSC Genes

Please enter the name of a file from your computer that contains a space, tab, or line separated list of the items you want to
include. The items must be values of the name field of the currently selected table, knownGene, or the alias field of the
alias table kgAlias. (The "describe table schema" button shows more information about the table fields)) Some example
values:

ucf02sjy.1

ucl02gww.1

uc003z=sf.1

Q86TZ5_HUMAN

QOERMT

Q86XY3_HUMAN

@

submit

5 Generate the output In the Table Browser page, click get output.

IMPORTANT! Do not change any other parameters.

output file: (leave blank to keep output in browser)

file type returned: @ plaintext O gzip compressed

get output [ summary/statistics ]

Tor 1l user cart settings (including custom tracks), click here.
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Configure the settings a.

In the Output known Gene as BED page, select Exons plus 0 bases at each end.

for the output b. Click get BED.

be truncated in order to avoid extending past the edge of the chromosome.
(6b Eget BED
|

Output knownGene as BED

[] Include custom track header:
name= |tb_knownGene
description= |table browser query on knownGene
visihility=| pack ¥

url=

Create one BED record per:
O Whole Gene

O Upstream by 200 bases

"%) Exons plus 0 bases at each end
O Introns plus ] bases at each end
O 5 UTR Exons

© Coding Exons

© 3' UTR Exons

O Downstream by | 200 bases

Note: if a feature is close to the beginning or end of a chromosome and upstream/downstream bases are added, they may

The UCSC Genome Browser generates the output as shown in the example below.

chrl 115630059 115630951 ucO0lefu.l exon 0 0 chrl 115630060 _x 0 -
chrl 115637770 115637894 ucO0lefu.l exon 1 0 chrl 115637771 r 0 -
chrl 115682347 115682380 uc00lefu.l_exon 2 0 chrl 115682348 r 0 -
chrl 115630213 115630939 uc009wgx.1l exon 0 0 chrl 115630214 r o -

o -

chrll 27633017 27636708 uc00lmrt.1l_exon 0 0_chrll 27633018 r

Save the BED output to a a.

data file

Select and copy all of the text displayed in the browser.
In Microsoft Excel, select Edit » Paste Special to paste the output into a blank worksheet.
In the Paste Special dialog, select Text in the Paste As field, then click OK.

Al B [ € | D E[Fl & |
|1 [chrl | 118630059 115630951 ucOOTefu.1_exon_0_0_chrl_115630060_r O -
| 2 [chrl | 118637770 115637894 uclO1efu.1_exan_1_0_chrl 115637771 r 0O -
|3 [chrl | 115682347 115682380 uclO1efu.1_exon_2 0 chrl 115682348 r 0O -
|4 [chrl | 118630213 115630933 ucli9wox.1_exon_0 0_chrl 115630214 r 0O-

Delete all columns except Chromosome, Exon Start, and Exon Stop coordinates
For example, in the figure above, keep columns A, B, and C and remove the rest.

In the Save As dialog box, enter a name for the coordinates list, select Text (Tab-
delimited)(*.txt) from the Save as type drop-down list, then click Save.

File narne: EDMF_sxample_coords|bxt hd
Save as type: | Text (Tab delimited) (* txt) v

If Excel warns you that:
e Your output format does not support multiple worksheets, click OK.

¢ Tab-delimited text may not support some characters, click Yes to ensure that the file
contains only text characters.

8

Submit the completed Email the saved tab-delimited text file (coordinates file) to Life Technologies along with your purchase
file order and the completed TargetSeq™ Custom Enrichment Kit Library Specification Form.
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Reviewing and approving your custom design

This section describes how to review and approve custom TargetSeq™ Custom Enrichment Kit designs sent to you by Life Technologies.

About the design file formats

After Life Technologies accepts your coordinates file and completes a probe design, you will receive a set of design files in an email from
the design team. Life Technologies provides design file(s) in the formats shown in the following table.

File format Extension View using...
BED (Browser Extensible Data) .bed UCSC Genome Browser (website)
Summary Design txt Microsoft WordPad or Notepad

Guidelines for reviewing your design files
Consider the following while reviewing your design:
e The .bed file contains the following tracks:

Track Description
primary_target_region Lists the genomic regions that you provided.
capture_target Lists regions actually covered by the design.

e When reviewing the design file, focus on gaps in the capture_target track that do not appear in the primary_target_region track. The
gaps represent portions of your target regions not covered by the design.

Note: If two or more of your target regions overlap, Life Technologies will merge them into one region. In addition, regions that are
less than 100bp will be padded to a minimum size of 100bp.

¢ Regions not covered by the design are usually repetitive regions that, if included, cause capture of other homologous regions in the
genome and decrease capture efficiency. Therefore, most TargetSeq™ panel experiments benefit from excluding these regions from
the design.

 The stringency filter Life Technologies uses by default will not include low-copy repeats (appearing 2-5 times in the genome] in the
design. If these regions are necessary to your research, indicate this requirement in the email to Life Technologies (see “Step 3. Approve
or request changes to the design” on page 11) and Life Technologies will use less stringent criteria in generating the design.

Note: Less-stringent designs may provide more genomic coverage but at the cost of decrease capture efficiency, resulting in more
off-target reads when the captured DNA is sequenced.

Note: If you have questions, contact Life Technologies Support (see “Obtaining support” on page 12).
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Step 1. Visually review the design

In this procedure, you will use the UCSC Genome Browser website to review the Browser Extensible Data (.bed) file that contains the probe
design provided by Life Technologies. For more information on the UCSC Genome Browser website, go to http://genome.ucsc.edu.

1 Save the BED file Save the BED file provided via email to your computer or a network drive.

2 Open the UCSC Genome a. Using a web browser, open the UCSC Genome Browser website (http://genome.ucsc.edul).

Browser Gateway b. In the left pane of the UCSC Genome Browser website, click Genome Browser.
3 Upload the custom a. In the Genome Browser Gateway page, select the options appropriate for your design in the
tracks genome and assembly list boxes.

Note: For example, this procedure uses “Human"” for the build and “Mar. 2006" as the assembly.

b. Click add custom tracks.

If the Gateway page displays the “manage custom tracks” button, click Click here to reset to
display the “add custom tracks” button.

c. In the Add Custom Tracks page, click Browse, upload the BED file, then click Submit.

4 Review the design a. In the Manage Custom Tracks page, click go to genome browser to view the regions.
The following figure shows an example design displayed in the UCSC Genome browser.

= Human cheB:128,141,104.-128,143,151 - UCSE Genome Browser w1 76 - Windows Internet Explorer

'g = bty e ucks achafegi-bimghg Trades Thids L A S004 00 Beattmgo-Hhord-garame-Hhrowsar postion=chr PR IA1 200 ¥ 5 | X =

B R e Fpoke ok beb

WG| g muman cheti 120,140, 104120, 143,151 - UCSC Gera, < o -k Bege = 0 Tock -

Heme Genomes Blat Tables Gene Sorter PCR DMA Convert Ensembl MNCBI PDFIPS  Session Help
UCSC Genome Browser on Human Mar. 2006 Assembly

move EEIBE: zoom in E}EE base | zoom out EEE
position/search ehed 128.141.104-128.143.157 g |[ clear | size 2,048 byp. |_configue

) [EEILrT EECEECT e [ETTrETT T |
Fargat Ragonn

g 107 Coweren ey T D i

e N
R, S
man EETE Thar Meve Been Epiices
TELI0ME EETE
VerTeorate Mabtis Aligneeet & Frastions Conmereat ion (b6 Spesiend

[ —

S
[ty

D 1E ST T S PO D AFRE (DTN 4000 1380
zex] || | 11

i
g g v s acesriasns

b. Review the design using the guidelines in “Guidelines for reviewing your design files” on page 9.

The UCSC Genome Browser provides the features in the table below to help you review the
design. For more information on the UCSC Genome Browser features, click Help.

To... Action

Zoom the view Click the zoom in and zoom out buttons to zoom in or out on the
center of the annotation tracks window by 1.5-, 3-, or 10-fold.

Scroll the view Click the move buttons to scroll to the left or right.

Display a different Enter coordinates in the position/search field, then click jump.
position in the genome

View the base Click base to view the base composition of the sequence
composition underlying the current annotation track display.

10
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Step 2. Review the Summary Design File

In this procedure, you will review the Summary Design File that contains the details of the custom design provided by Life Technologies.

1 Open the summary Open the summary design file (.txt) using a text editor, such as Microsoft WordPad, Microsoft Notepad,
design file or Microsoft Excel.

2 Review the design to Review each field to ensure that the design meets the specifications for your project. See the table
ensure that it meets below for more information on the summary design file fields.

your specifications

rg | I 5 + | Sample_probe_coverage_summary - ... l‘:' B S
Home View (7]
-g---|---1---|---2---|---3---|---4---
Genome :HG1E
Offset in bases Q 100
Il Consolidated/Padded Regions 2a 2a
Target bases 3740787 3740787
| Target bases covered 2695988 3063393
Percent target bases covered 72.1 81.9
Target bases not covered 1044799 677394
(| Percent target bases not covered 27.9 18.1
i
| < i +
| 100% (=) { )]
Field Definition
Genome The genome and build targeted by the design.
Offset in bases The amount of additional padding added to both sides of probe to simulate
additional coverage from sequence of captured fragments.
Consolidated/ The number of regions in target file(s) after overlapping regions have been
Padded Regions padded and merged.
Target bases The number of bases in the merged target regions.
Target bases The number of bases of merged targets that are covered by probes using the
covered given offset.
Percent target The percentage of merged targets that are covered by probes using the given
bases covered offset.

Target bases not The number of bases of merged targets that are not covered by any probe
covered sequence using the given offset.

Percent target The percentage of merged targets that are not covered by any probe
bases not covered | sequence using the given offset.

Step 3. Approve or request changes to the design
After you have reviewed the design files, you can:
e Approve the design
e Request changes to the design
¢ Request additional information from Life Technologies if you have questions on the design

For tracking purposes, reply to the email that included the design files with the proposed design. In your reply, either indicate that you
approve the design or specify any changes needed for approval.

IMPORTANT! Life Technologies cannot finalize the design and produce the TargetSeq™ capture probe pools until we receive approval.

11
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Obtaining support

For the latest services and support information for all locations, go to:
www.iontorrent.com/support/ or www.lifetechnologies.com/support
At the website, you can:
¢ Access worldwide telephone and fax numbers to contact Technical Support and Sales facilities
e Search through frequently asked questions (FAQs)
e Submit a question directly to Technical Support
e Search for user documents, application notes, and other product support documents

For Research Use Only. Not intended for any animal or human therapeutic or diagnostic use.
COPYRIGHT

© 2011, Life Technologies Corporation. All rights reserved. Beyond a single download for personal use, no part of this publication may be reproduced, transmitted, transcribed, stored in retrieval
systems, or translated into any language or computer language, in any form or by any means: electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without prior written
permission from lon Torrent Systems, Inc.

The information in this guide is subject to change without notice. lon Torrent Systems reserves the right to change its products and services at any time to incorporate technological developments.
Although this guide has been prepared with every precaution to ensure accuracy, lon Torrent Systems assumes no liability for any errors or omissions, nor for any damages resulting from the
application or use of this information. lon Torrent Systems welcomes customer input on corrections and suggestions for improvement.

TRADEMARKS
The trademarks mentioned herein are the property of Life Technologies Corporation or their respective owners.
LIMITED LICENSE
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at: USA
1-87-SEQUENCE (1-877-378-3623) lon Torrent
llfyou are located outside of North America, please contact lon ;ﬂ?tg SZE?reline Court
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+1-203-458-8552 USA
Headquarters ’
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